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WARRANTY: Baumann Electronic Controls is dedicated to producing the highest quality
products available in the industry and is committed to customer satisfaction. Because we
have no control over the circumstances under which our products are used, we can assume
no more responsibility for damages (consequential or otherwise) or defects in materials and
workmanship than the original purchase price of our product. Baumann Electronic
Controls will repair or replace all defective components unconditionally for a period of three
years from date of sale. This Warranty does not cover damages due to abuse or improper
application or connection of the device. After the Warranty period, Baumann Electronic
Controls will service this device for a nominal fee.

Introduction to the Baumann Tuning System Software:
The Baumann Tuning System software provides adjustment, tuning, and diagnostic capabilities for the
Shiftware TCS Transmission Control System.
Four basic steps must be performed to create and use a TCS calibration. First, all of the basic vehicle and
system parameters must be set. Once this has been done, the shift points and line pressure curve are
determined using the graphical tuning interface. Once the calibration is complete, it should be saved to disk so
that it may be retrieved later. Finally, the completed calibration should be written to the TCS using either a
laptop PC or a desktop PC in conjunction with the optional AC adapter. When modifying an existing
calibration, some of these steps may be unnecessary.
We also supply a variety of useful and proven calibration files for all of the transmissions that we support.
These files are named for the transmission that they were created for and the RPM range that the shift point
curves are calibrated for. One of these files may provide a good starting point for your calibration and may
only require minor changes to the system settings to work for your application. To open one of the standard
calibrations, select “Open” from the file menu, or click the open button on the toolbar.
Configuring the System Settings:
The various system settings are presented in either a tabbed dialog format (for the Show System Settings
toolbar button , or the “Configure System Settings” option on the View menu), or as a step-by-step wizard
when either the Initial Setup Wizard option is selected or when a new file is created. The content of both
formats is generally the same, but the purpose is slightly different. The wizard is intended to guide someone
through in a step-wise manner when they are first setting up a new file, while the tabbed system settings
interface is designed for subsequent changes and fine-tuning, and it can be left open while performing other
tasks. The controls and functions of both are nearly identical, though.
The controls used in the system settings tabs or pages are unique to each transmission type and application.
Many controls or even whole tabs will only be available (or needed) for certain transmission types. Since the
content of these tabs is dynamic, we have provided specific help for these controls within each tab or page.
Generally, each control in the system settings tabs will have context sensitive help available by pressing the F1
key while using the control.
You can also click the help (question mark ) button at the top-right corner of the settings window, then click
on the control of interest. Please note that the help button in the toolbar of the main window will not work for
the system settings controls. You must use the help button on the settings window.
You can click on a control in one of the tabs to select it for editing, or you can use the tab key to navigate
between controls. When using the tab key in the system settings tabbed interface, you can highlight the tab of
the current page, then use the arrow keys to navigate between the available pages.
You can modify the value of numeric controls (such as axle ratio, tire diameter, etc.) by typing in a new value,
or you can adjust (scroll) the value up or down by using the up and down arrow keys or the mouse wheel. The

changes to a control setting are effective immediately if you are scrolling the value, or as soon as you hit the
ENTER key or move to the next control, when you are typing in a value. The effects of changes that affect the
graph and other items will be immediately obvious, as the system will update in real time.
All of the other controls on the settings pages work similar to those of other Windows programs. In some
cases, there may also be a pushbutton available on a page offering additional help. You can press these
buttons to open detailed help documents regarding these features.

The most critical parameter is “Transmission Type”, which must be configured properly to enable the system
to function. If you are unsure about the transmission type to use, please consult Baumann Electronic Controls
for guidance.
Rear axle ratio and tire diameter parameters are necessary to provide accurate mile per hour and RPM values
for shift points and should be entered as accurately as possible.
Another important setting is “Idle TPS Voltage” in the “Throttle Position Sensor” tab. This setting provides a
starting point to index the throttle position sensor to the correct table cell in the shift point graph relative to
current throttle position. This value should be set to the actual TPS voltage at hot idle. If the system is
currently connected to the vehicle, you may click the “Set Idle TPS” button to configure this value
automatically.

The Main TCS Window:

The main window is where all of the shift point and line pressure editing is done. It also serves as the control
center from which to load and save data files and to write or read a data file from the permanent calibration
memory in the TCS unit.
The main window is centered around the shift point and line pressure graph, which can display the upshift and
downshift speeds versus throttle position for specific shifts (e.g. 1-2 and 2-1) and the EPC solenoid current
(line pressure) versus throttle position. Line pressure is inversely proportional to EPC current, thus the lower
the line pressure curve is at a given throttle position, the higher line pressure will be.
The graph is displayed with ten cells or points from left to right. The left-most point represents the value for
idle, while the right-most point represents the value for wide-open-throttle (WOT).
Click on a point or vertex in the graph to select it. If automatic downshift selection is enabled, then the
corresponding downshift point will also be selected when you select an upshift point.
When a point is selected, it will be highlighted with an orange filled circle. You can select multiple points by

holding down the CTRL key and clicking the desired points. To select a range of points, click the first point,
then hold down the SHIFT key while selecting the last point desired.
Once a point (or points) is selected, you can drag it with the mouse, use the up and down arrow keys, or scroll
the mouse wheel to raise or lower its value. You can use the left or right arrow keys to move left or right
between adjacent points on the graph. Holding down the SHIFT key while using the arrow keys will
“accelerate” the arrow keys, increasing their effect.
A yellow “call-out” box will be displayed at the top-left corner of the graph window to indicate the current
value of the point being edited. The call-out box will also display the value of graph points as the mouse
pointer hovers over them.
When the “Auto” button under “Downshift Select” in the graph legend is selected (checked), the
corresponding downshift point(s) will also be selected when you select an upshift point or points. This is the
best mode to use for general shift point editing and scaling. To adjust the hysteresis (or deadband) between the
upshift and downshift point for a desired shift and to fine tune shift behavior, you can un-check the auto select
mode button as needed. This button has no effect for the line pressure curve.
It is important that the upshift and downshift curves for a given gear do not cross. In fact, the upshift point
value at any given throttle position should generally be at least 15% greater than the downshift value at that
point. For example, if the 2-3 upshift point at one-half throttle is 45 MPH, then the 3-2 downshift point should
probably be less than 40 MPH.
This “on-off” differential between the upshift and downshift points is referred to as the hysteresis (or
deadband) of the shift. This is an important concept, because the more hysteresis you utilize for your shift
points, the more stable the system will be. Using too little hysteresis can result in “hunting” between gears or
busy shifting and erratic shift behavior. Too much hysteresis will create a sluggish calibration, which is
reluctant to downshift.
In addition, pay close attention to the interaction between different shifts. Overlapping the 1-2 and 2-3 shifts,
for instance, can cause skipped gears and other drivability problems. This software provides the flexibility to
do almost anything, but it also requires diligence to avoid errors.
It is also important to note that torque converter slip at low vehicle speeds renders engine RPM values
meaningless under these conditions. It is both possible and desirable to have light-throttle shift points within
this low speed range. In this case, it is best to base light throttle shift points on vehicle speed, rather than
engine RPM (as is typical for auto manufacturers).

Saving and Loading TCS data files:
Once the shift points and other data are edited as necessary, the results should be saved to your computer's
hard disk, a flash drive, or other storage medium. To save the changes to your current file, simply click the
“Save” button in the toolbar. This can also be accomplished by choosing “Save” from the File menu or by
holding the CTRL key and pressing the S key.
If you have made changes to an existing file and wish to be able to retrieve the original, unmodified copy (as a
baseline, for example) at a later time, you should select “Save As” from the File menu. This will cause the
“Save As” dialog box to appear, allowing you to edit the original file name or type in a new one. A list of
existing transmission calibration (*.BTC) files will be shown in the “Save As” dialog box.
Once you have entered a filename, click the “OK” button or press the “Enter” key to save the file. If you
choose the name of an existing file, you will be asked to confirm that you want to replace to existing file.
Selecting “Yes” will overwrite the original file, while “No” will simply return you to the “Save As” dialog
box.
As with most “Open” or “Save As” dialog boxes in Microsoft Windows (R), you may choose the disk drive
and folder in which to save or open the file. The desired drive and folder can be selected by clicking the down
arrow to the right of the “Save in:” box. To save or open files on a floppy disk, for example, select the “A:”
drive in the “Save in:” box. To go up one folder level, simply double-click on the folder above the current
one. The highest folder level is referred to as the “Root” folder (for example, “C:\” is the root folder of the
“C:” drive).
Writing a calibration to the controller:
In order for calibration changes to be effective, the calibration must be written to your controller. Use the
“Write Calibration to Controller” selection in the file menu or the corresponding toolbar button to write the
currently open calibration file to the selected table of the controller. Once the calibration write is complete, a
message will be displayed in the status bar to indicate that it was written successfully.
The controller has two tables in which calibrations can be stored. The active table to be read/written by this
software is selected using the ‘1’ and ‘2’ toolbar buttons or the corresponding file menu options. In the
vehicle, the table select input (pin 11, purple or black wire) is used to select which table the controller will
operate from while driving. When 12 volts are applied to the table select input, table #2 will be used.
Otherwise, Table #1 will be used for driving.
When no controller is connected, the “Write Calibration to Controller” menu option and toolbar button will be
grayed-out.

